
Photo Collages
Photo collages are compilations or collections of images and pictures that persons or
groups put together to create a single photo. Photo collages are creative pieces of art that
individuals can use to construct breathtaking products.

Photo Collage Definition & Meaning

A photo collage is a picture that individuals make by compiling and forming photos on a
cloth or piece of paper.

These collages take time to design and produce, with people making them using a
computer program or software or completely handmade.

What Is A Photo Collage?

A photo collage is a form of visual artistry that incorporates visual elements, such as
professional photography, in developing a new vision that conveys a specific idea, story, or
message. The word collage comes from the French word collér, meaning to glue, and more
often than not, it is the primary means of combining photographs and other elements for



new artwork. Photo collages use images, pictures, and photographs from magazines,
newspapers, and other print materials, applying them to a blank canvas for a new layout.

10 Types of Photo Collage

Birthday Photo Collage

Celebrate a birthday occasion by creating a birthday photo collage using various visual
elements that can accentuate the party theme. Use animal prints for a zoo-themed birthday
or clip arts of trees, flowers, and other nature-themed objects to add to the portrait. Use a
modern photo editor or handcraft the collage to make it more heartfelt and meaningful to the
person celebrating their birthday.

https://www.template.net/editable/33599/birthday-photo-collage


Family Photo Collage

Celebrate the gift of a family with a beautiful family photo collage to commemorate all the
unforgettable memories and moments to look back on forever. Incorporate all the happy
faces of relatives through the years during different events and occasions that light up the
entire room. When creating the collage, it is best to use natural and unfiltered photos that
will always make it one for the books.

https://www.template.net/editable/33600/family-photo-collage


Wedding Photo Collage

Love is always worth celebrating, and what better way to showcase the love between two
people than a gorgeous and intimate wedding? Collate the multiple photographs of the
happy couple into a heart-shaped canvas and send them as a gift, or incorporate the
collage into a video presentation during the wedding ceremony, looking back on the
memories between the couple. The couple can have the option to display the wedding
photo collage in their home or bedroom to remember the memorable occasion.

https://www.template.net/editable/33606/wedding-photo-collage
https://www.template.net/editable/33606/wedding-photo-collage


Travel Photo Collage

People travel to gain experiences, feel different cultures, eat delicious food and cuisine, and
meet people of various beliefs and ethnicity to expand their knowledge about diverse
places, cultures, and groups of people. Nowadays, it is easier to store memories and
experiences through blog posts, personal websites, and other social media platforms like
Instagram, Pinterest, and Facebook. Generate a travel photo collage to post on a digital
channel, use a custom wallpaper, or display as framed artwork.

https://www.template.net/editable/33560/travel-photo-collage


Storyboard Photo Collage

A photo storyboard or collage is a visual outline or representation to display multiple images
or similar photos to organize information or develop a story. Individuals can utilize
storyboards to draw ideas, write ideas, or both, usually a single-page document with panels
or blocks containing the flow of stories and ideas logically. Create a comprehensive
storyboard photo collage for your next project, editable in photo editing applications like
Adobe Photoshop.

https://www.template.net/editable/33559/storyboard-photo-collage


Anniversary Photo Collage

People celebrate significant dates like anniversaries, birthdays, and special occasions by
presenting handwritten letters, cards, and unique gifts. The number of these presents is
irrelevant, especially when a person gives it with sincerity. Try something new by creating
an anniversary photo collage containing a plethora of memories and events from years
before.

https://www.template.net/editable/75441/anniversary-photo-collage


Holiday Photo Collage

Every holiday consists of fond and unforgettable memories that family, friends, and
colleagues share and celebrate throughout the year. Make each one special by taking lots
of photos and videos, from funny moments to more intimate ones, and remember that
sharing the time with special people in our lives is worth remembering. Cherish and capture
these memories by incorporating photographs and still images in a creative holiday photo
collage.

https://www.template.net/editable/75292/holiday-photo-collage
https://www.template.net/editable/75292/holiday-photo-collage


Fashion Photo Collage

Various fashion companies and industries hold annual fashion shows to showcase and
launch their newest collections by giving a glimpse to artists, influencers,  and the media,
making each one memorable for the public. Behind the scenes, designers and production
teams work tirelessly to combine their ideas and visions to create a program that entices the
viewers. Develop a fashion photo collage to create a visual storyline of the sets of clothing,
apparel, and accessories the fashion show presents to its patrons.

https://www.template.net/editable/33601/fashion-photo-collage


Wall Photo Collage

Memories will always live in photographs. Photographs capture and document events and
experiences, keeping them for the longest time. Photography allows individuals to see little
details that they might have missed or forgotten during a particular situation and want to
remember them. Place these photographs together in a wall photo collage, and continue
adding to the collection with each new adventure.

https://www.template.net/editable/75773/wall-photo-collage


School Photo Collage

Educational institutions encourage students to complete and develop school photo collages
about different subjects and topics to foster creativity and enhance story-telling skills. These
collages also help students develop their collaborative, communication, and interpersonal
skills when interacting with their fellow students. View our example of an editable school
photo collage for your next school project.

https://www.template.net/editable/33557/school-photo-collage
https://www.template.net/editable/33557/school-photo-collage


Photo Collage Uses, Purpose, Importance

Making a photo collage is more than just compiling photos and different materials together;
it is a form of art that people create to remember details about past experiences or create a
new visual artwork altogether. The list below informs individuals of the multiple uses and
importance of creating a photo collage.

It Tells a Story

A person does not need to be very creative or be thoroughly accustomed to design to
create photo collages. Photo collages allow people to show their family trips and vacations,
the journey of a couple through their ups and downs before their marriage, or a visual
representation of a student’s high school life leading to graduation. Select the best images,
photographs, and other scrapbooking elements that best represent the experience.

Displays a Photo Collection with Ease

It is more likely for an individual to capture moments in photographs more than once, having
them browse through multiple numbers of prints to showcase. Photo collages make it easier
for groups, individuals, expert photographers, and visual artists to display a variety of
photosets, making it simple and convenient. People use various themes to catch the
audience’s attention, and businesses also utilize them in their digital content and portfolios.

Helps Represent Progress

Many photo collages show transitions from one stage to another. Many individuals use them
to document the progress of their child’s first year, a child’s school years, and even the
progress of a couple towards their wedding day. Collecting all the photographs, items, or
trinkets associated with these events and incorporating them in the photo collage makes it
more meaningful.



Enhances Creativity and Style

Plain photo displays in frames can be dull on a bare wall. Individuals can experiment and
become more creative and adventurous with designing and displaying photographs through
a photo collage. There is no need for an individual to master artistry or take a design course
in college to create beautiful and captivating collages, as you can get ideas from online sites
like Pinterest.

Creating Photo Collages Can Be Therapeutic

For many individuals, organizing things like photographs and incorporating different
elements into them like shapes and other decorative pieces is therapeutic. It is a form of
emotional release, like a breath of fresh air. Creating something a new material out of
different elements coming together to form meaningful objects can bring back memories
and help construct new ones.

What’s in a Photo Collage? Parts?

Photos

The main element of any photo collage work is the photographs. The images that an
individual incorporates into the collage range from cutouts from magazines, newspapers,
and other printed materials, printed photos from various websites, or personal images the
person has taken from a smartphone or a camera.

Shapes

Many photo collages incorporate shapes to add uniqueness and creativity. These shapes
make the visual artwork distinct from others, pairing these shapes together to form new and
meaningful images.

Texts

Several photo collages incorporate text elements to accompany photos and other
components to enhance the overall presentation of the artwork. Individuals can also
comprise texts with various fonts, including cursive, serif, sans serif, or fancy.



Frames

Photo collages consist of many photos in different shapes and sizes. Frames provide a
distinct look for each photograph and accommodate them into the art piece to create depth
and still keep each image separate on its own.

Background

Individuals use different materials for the background of their photo collage. The materials
range from cloth, fabrics, colorful papers, and hard stock materials, depending on the theme
and what the person wants to achieve.



How To Design a Photo Collage?

1. Determine the Photo Collage Size

2. Specify the Purpose of Creating the Photo Collage

3. Pick the Photo Collage Template

4. Prepare the Photographs and Visual Elements for the Collage

https://www.template.net/editable/photo-collage


5. Formulate a Theme To Use for the Collage

6. Combine All the Materials To Complete the Photo Collage



Photo Collage Vs. Grid

Photo collages are visual art forms that emphasize the use of photos and other visual
elements to tell a story or share an idea with its viewers.

Meanwhile, photo grids are more traditional marketing tools, displaying more of the product
information for viewers and consumers rather than showing a variety of product photos.

What’s the Difference Between a Photo Collage, Photo
Montage, and Photo Frame?

Photo collages are a collection of photographs, images, and other visual elements to create
a new artwork that tells a story, a message, or an idea.

A photo montage is an assembly of several photographs or images relating to each other to
produce a combination or sequence of visual images to create an entirely new picture.

A photo frame is an object that holds a photograph or series of pictures made out of wood,
plastic, glass, or metal for display.

Photo Collage Sizes

Standardized dimensions enable individuals to print the collage on high-quality photo paper
for the best image quality when making photo collages using an online editing website or a
photo editing software. The list below details the different photo collage sizes individuals
can print on photo paper.



Photo Collage Ideas & Examples

People can make photo collages to remember special events and memories in the past,
creating a new visual art form as a gift or a decoration. Businesses can also utilize making a
photo collage for different purposes and events, similar to our list of templates of photo
collage ideas and examples below, using an Android or Apple phone.

● Photo Collage Ideas and Examples
● Retirement Photo Collage Ideas and Examples
● Unique Ideas for Memorial Collage Examples
● Music Photo Collage Ideas and Examples
● Love Photo Collage Ideas and Examples
● Graduation Photo Collage Ideas and Examples
● Vacation Photo Collage Ideas and Examples
● Photo Collage Ideas and Examples for Interior Design



● Friends Photo Collage Ideas and Examples
● Baby Photo Collage Ideas and Examples
● Sports Photo Collage Ideas and Examples

Photo Collage FAQs

How do I make a photo collage on iPhone?

Mac products, like an iPhone, have applications an individual can download to create a
photo collage by uploading the photos on the app and saving the final product on the
phone.

How to make a photo collage on Facebook?

Facebook now has an auto collage feature that allows users to upload multiple photos and
select a layout for the set of photos.

How to design a photo collage in Photoshop?

Begin by opening the Adobe Photoshop application, click the File menu, select New for a
blank image, set the dimensions to the desired photo size, open the photos for the collage
in the application, and select and drag the pictures to the file photo collage.

How to make a wedding photo collage with music?

Open a media-editing application like Adobe Express, select the format for the workspace,
select a theme, incorporate the music, and save the work for the photo collage.

What is the best way to make a photo collage?

The best way to make a photo collage is by using ready-made and editable photo collage
templates through an online website or photo editing software.



How do I print photo collages using Illustrator?

To print a photo collage in Illustrator, open the photo collage file in the Adobe Illustrator
application or create the photo collage file using the program, click the File menu, and
select Print.

What does a photo collage look like?

A photo collage is a collection of images that tells a story, shares an idea, or delivers a
message to its target audience.

How to create a digital photo collage?

To create a digital photo collage, individuals can choose to upload and combine images
through an online website or a photo editing application like Adobe Photoshop, Illustrator,
and Express.

What is the best program to make a photo collage?

The best program to make a photo collage is Adobe Spark.

How do you create a photo collage in Microsoft Word?

Create a photo collage in Microsoft Word by using the Developer tab, selecting the Picture
Content Control option, adding all the image slots you need, uploading the image, and
editing the dimensions for each photo by dragging the sides of each photo.


